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Book1 - Print Manager 

T27 eXpress Print Manager 
The T27 eXpress Print Manager is used to manage, configure and monitor print jobs initiated through 
the T27 eXpress Enterprise emulator. 

Note: All menu selections described below have a corresponding button on the toolbar. 

File menu 

The File menu contains the controls to connect, configure, add and delete printer environments. 

Start/Stop Selected Printer 

Use this control to start and stop selected printer services. 

Configure Selected Printer 

Use this control to change the configuration settings for the selected printer. 

Add New Printer 

Use this control to add a new printer environment to the Print Manager. 

Delete Selected Printer 

Use this control to delete a selected printer. 

Change Settings Location  

This selection allows the maintenance of configuration settings in one location for all users of 
this software or in individual locations for each user. 

Close 

Use this control to close the T27 eXpress Print Manager. 

View menu 

The View menu contains the control that allows you to view the progress of a selected print 
environment. 

Show Selected Printer Window 

Use this selection to display the PTS dialog.  This dialog displays the status, bytes printed and 
bytes printed since the service was first started. 

If a trace option was configured for the printer environment, use this selection to initiate the 
trace option selected. 

Options 

The Options menu has one selection to be used for obtaining a transport trace at the request of KMSYS 
Worldwide Support Personnel. 

Transport Trace 

Select this option to initiate a Transport Trace.  Use this option only when directed by KMSYS 
Support Personnel. 

 

T27 eXpress Print Server Configuration 

Environment tab 

This tab is used to establish the printing environment. 

Printer Environment 

The controls in this group are used to equate a configured route to the environment name.  To 
assign a route, select a configured route that will be used as a printer from the Available 
Connection Routes list box and press the Assign Selected Routes button.  If a route has not 
been configured previously, click the Configure button to start the QPort TCP/IP Visual 
Configuration program and configure a new route.  Note: Choose PRINTER as the Terminal Type 
for the new route. 

Name 

The environment name may be any name of your choosing. 

Select Connection Point (Destination) 
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From this drop-down list box, select a configured destination to be used when the 
screen is opened.  If additional destinations are required, use the Configure 
Connections button. 

Configure Connections 

Click this button to configure the virtual destinations required to connect to a host.  
When complete, use the Select Connection Point drop-down list box to link a newly 
configured destination. 

Station Name 

In this text box, enter a station name as configured in COMS on the mainframe.  This 
name will be passed to the ClearPath MCP host. 

Open on startup 

Check this box to cause the environment to connect automatically to the host on Print 
Service Manager startup. 

Use keep-alive 

Keep-alive will attempt to reconnect when the network connection is lost due to 
inactivity or line problems.  The first retry will occur immediately and subsequent 
attempts occur every minute thereafter until the connection is re-established or the 
print server is closed. 

Auto-reconnect idle minutes (0 for none) 

You can configure an inactivity interval, at which point the connection will close and 
reopen.  Specify the interval in minutes (60 recommended).  If zero (the default) is 
entered, this feature is disabled.   Normally, no reopen occurs during printing; 
however, a low paper supply or other condition causing a print interruption could allow 
for an interval reopen. 

Trace on Start Option 

Use one of the mutually exclusive option buttons in this group to trace the connection 
activity to the host.   

Destination Device tab 

This tab is used to link the printer environment to a local or network printer.  The tab is also used to 
select the type of printing, printer orientation and page size. 

Printing Method 

In this group, choose one of three printing methods. 

Normal Windows Printing 

Set this option if the output is to be sent to the printer using a Windows print driver.  
Note: This option should not be selected if there are any embedded formatting codes 
in the data; e.g., do not use for passthrough printing. 

Windows Print Bypass 

Set this option to bypass the Windows printing and send directly to the printer.  This 
option should be set for passthrough printing. 

Print to File 

Set this option if the output is to be saved in a PC file. 

Spooling 

Set the spooling option to specify whether the print should be sent directly to the 
printer or spooled to disk before printing. 

Windows Printer 

From this drop-down list box, select an installed printer driver. 

Select Font 

Click this button to select from all fonts installed on this PC. 

Printer Orientation 

Set the printer orientation to either Portrait or Landscape. 
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Page Size 

Set the page size to the desire number of Columns and Lines. 

Processing tab 

This tab is used to specify the means by which print data is handled coming from the host. 

Data Compression Method 

In this group, choose the compression method that is supported. 

None 

No compression takes place. 

Standard T27 Method 

Supports repeated spaces being compressed by the host program using an escape 
sequence.  The host program sends the escape character (hex 1B) followed by an open 
bracket, a number representing the number of spaces compressed and the letter "a" 
that acts as the terminating character of the escape sequence.  For example, the 
compressed string, "<ESC>[12a", expands to 12 consecutive spaces.   

This is the normal method for T27 operations. 

Tab Method 

Supports repeated spaces being compressed using a tab character (hex 09) followed 
by a number representing the number of spaces compressed.  For example, the 
compressed string, "<TAB>12", expands to 12 consecutive spaces. 

Timeout 

Use this spin box to specify how long the Print Service Manager will wait for additional print 
data before automatically closing the printer. 

Misc. 

The options in this group may be used to identify and convert special character sequences in 
the print data. 

Support ESC ESC P Redirection 

Check this box if the host program is supplying printer redirection escape sequences to 
a file.  For example, "<ESC><ESC>Pc:\adir\afile.txt<CR>" will redirect the print to the 
file, afile.txt, in the directory, adir, on the c: drive. 

Convert CR to CR LF (Windows print bypass only) 

Check this box to convert any single "<CR>" return to a "<CR><LF>". 

Strip ASCII Control Characters (ASCII 00-31) 

Check this box to eliminate any ASCII special characters (ASCII 00 through 31). 

Host to Printer Character Translations 

Optionally use the entries in this table to specify the ASCII characters that eXpress Enterprise is 
to substitute when receiving special ASCII characters from the host. 

Host Char. 

In this column, enter the decimal representation of the anticipated ASCII host 
character. 

Print Char. 1 through Print Char. 4 

In these columns, enter the decimal representation of the ASCII replacement 
character(s) sent to the printer. 

Example of translating the tilde (~) to the Esc character: 

Host Print 

Char Char 1 

126 27 

Note: For additional rows in the table, click the Add Row button.  The new row inserts at the 
bottom of the table.  Use the Delete Row button to delete a selected row. 

Character Translation Table 

From this drop-down list box, select the desired character set. 
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Edit Character Translation 

Press this button to select and edit character translation sets for specific countries. 

Print File Options tab 

This tab is used to direct printed output to a printer and/or file. 

Print to 

Click one of three mutually exclusive radio buttons in this group: 1) Printer Only (default), 2) 
Printer and file or 3) File only. 

File Name Option 

Select one of two mutually exclusive options in this group: 1) by prompting for file name or 2) 
automatically use date and time. 

Default File Path 

Click the Browse button to change the destination path of the print file.  The default is the 
Windows desktop. 

Note: To Print or Reprint a file, the desired Printer must be Started.  There will be a "Reprint" 
button at the bottom of the Print Service dialog.  That button brings up a dialog that allows the 
user to select a printer and a file.  Once OK’ed, the file will be printed.  The file does not have to 
be processed using the original printer configuration that was used when it was created. 

 

Reprint from File 
Use this dialog box to select a printer and print file for printing. 

Select Printer 

From this list box, select the destination printer. 

Reprint File 

Enter the path and file name of the file to be printed, or use the Browse button to select the file. 

 

Character Translation 
This window provides the ability to select and edit character translation sets for specific countries. 

Select/Create Translation Tables 

This group allows you to maintain the tables for character translation. 

Currently selected table 

This box displays the currently selected table. 

Select Table Name 

Select the translation set (the default is NO TRANSLATION) for your locality. 

Add 

To add a translation set, click the Add button.  A second window will appear where you may 
enter a country name that will correspond to the translation set. 

Edit 

To change one or more characters in a translation set, highlight a country name using the left 
mouse button or the up/down arrow keys and edit a character with the controls on the right 
under Edit Character Translation Table. 

Delete 

To delete a translation set, highlight a country name using the left mouse button or the 
up/down arrow keys and click the Delete button. 

Edit Character Translation Table 

This group allows you to specify host character and local character pairs for translation on all data 
received from, or sent to, the host during an eXpress Enterprise session. 

Character translation table 

Select an existing character in the translation table using the scroll bar, mouse and/or up/down 
arrow keys.  Type any changes into the two text boxes (Host and Local) at the bottom of the 
window. 
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Add Char 

To add a new character, select each of the two text boxes (Host and Local) at the bottom of 
the window, enter the new values and click the Add Char button. 

Delete Char 

To delete an existing character, select a character in the translation table using the scroll bar, 
mouse and/or up/down arrow keys and click the Delete Char button. 

Move Up 

Use this button to move the selected character in the translation table up one entry. 

Move Down 

Use this button to move the selected character in the translation table down one entry. 

Edit Selected Character 

Use the controls in this group to enter the codes for the selected character. 

Host 

Enter the character code as it appears on the host. 

Local 

Enter the character code as it appears on the PC. 

Character Edit Mode 

Select one of two options for entering the character codes, above: Decimal or 
Hexadecimal. 

Import 

Use this button to import an existing character translation file (.ini). 

Export 

Use this button to save the current character translation configuration to a file. 

 

Change Settings Location 
The purpose of this feature is to allow all users of a single machine (Windows system) to use the same 
configuration settings for the T27 eXpress Enterprise terminal emulator and/or the eXpress Connect 
host connections.  By default, all emulator settings are saved in files for the current user, which allows 
multiple users on the same machine to have their own individual settings.   

In some cases, it may be desirable to have one set of configuration settings used by all users of the 
machine.  One reason for common settings is so that the configuration settings can be established once 
for all users, instead of for each individual user; however, users should NOT be allowed to make 
configuration changes once they are set.  There should only be one person allowed to maintain the 
configuration.  If common configuration settings are desired, the emulator settings will be stored in 
common files and removed from current user. 

Use this dialog to switch the location of the T27 eXpress Enterprise configuration settings.  The settings 
may be stored in such a manner as to allow multiple users of a single Windows system to maintain 
their individual configurations.  When individual configurations are to be maintained (the default), the 
settings are placed under <Current User> in Application Data.  On the other hand, if it is desirable for 
all users of the system to use the same configuration, an option is available to move those settings to 
the common location, "All Users".  Note: See the %APPDATA% system variable. 

Note: "<Current User>" will be the user-id used to log on to Windows. 

The dialog acts as a toggle between <Current User> and All Users; i.e., if your settings are currently 
stored in <Current User>, the message will indicate that they be moved to All Users; if they are in All 
Users, the move would be to <Current User>. 

Screen and General Settings 

Select an option in this group to move the screen and general settings.   

Current Location 

The option set when the dialog first appears represents the location currently used to house the 
configuration files.  To move the settings, select the opposing option and click the Apply 
button. 

Connection Settings 
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Select an option in this group to move the connection settings.   

Current Location 

The option set when the dialog first appears represents the location currently used to house the 
configuration files.  To move the settings, select the opposing option and click the Apply 
button. 
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Book2 - Connections 

eXpress Connections Configuration 
Use this window to control the overall operation of the configuration process and to configure 
connections to a host, visually. 

In the work area, there is a column of virtual destinations to hosts.  At the top the column, there is a 
row of action buttons for managing the destinations (add, edit, duplicate, etc.). 

The following is a description of each mouse action and button: 

Mouse Actions 

Select an Existing Virtual Destination 

Use the left mouse button to select an existing virtual destination.   

Edit an Existing Virtual Destination 

Double-click the left mouse button on an existing virtual destination to open a configuration 
dialog to edit the required parameters. 

Menus and Tool Bar Buttons 

File 

Save and Close 

This selection saves changes made to the configuration and exits the eXpress Connect 
Virtual Configuration routine. 

Print 

This selection will print the eXpress Connect Visual Configuration window.  The 
standard Windows Print dialog will appear allowing printer selection and property 
adjustments for the selected printer. 

Cancel and Close 

This selection discards any changes made and exits the configuration routine.   

Edit 

Sort 

This selection will sort the virtual destinations in alphabetical order on the visual 
configuration window. 

Help 

Pressing this button pops up a menu with the following selections: 

Contents 

This selection displays the help Contents tab for the eXpress Connect configuration 
program. 

About 

This selection displays the copyright information about the eXpress Connect Visual 
Configuration. 

Virtual Destinations 

Use these controls to manage virtual destinations: 

Add button 

Add a new virtual destination. 

Edit button 

Edit the selected virtual destination. 

Duplicate button 

Duplicate the selected virtual destination. 

Delete button 

Delete the selected virtual destination. 

Sort button 
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Sort the virtual destinations in the list in alphabetical order. 

Move Up button 

Move the selected virtual destination up in the list. 

Move Down button 

Move the selected virtual destination down in the list. 

 

Edit Virtual Destination 
Use this window to define a potential host. 

Virtual Destination Id 

This is the name of the configured Virtual Destination.  Enter any meaningful name. 

IP Address 

In this text box, enter an IP address (in "dotted" notation or symbolic destination machine name) of a 
host. 

When using a Host Gate Server from KMSYS Worldwide, this is the IP Address of the server – not the 
host. 

Edit IP Address 

Click this button to edit the IP address of the destination.  Use the context sensitive help provided for 
further assistance. 

IP Port Id 

This is the IP port for your site (normally, 23).  For SSL connections through Host Gateway Server (HGS) 
from KMSYS Worldwide, 992 is the accepted standard. 

Connection Type 

UNISYS (A-Series), UNIGATE (V-Series), Local (PCA) and KMSYS Host Gateway Server are currently the 
only supported connection types. 

SSL Options 

Note: This feature is not available for users of T27 eXpress IT.  If encryption and authentication is 
required, please contact KMSYS Worldwide, Inc. for pricing on T27 eXpress Enterprise. 

When utilizing the KMSYS Host Gateway Server, you may specify authentication and encryption.  
Authentication validates the connection between the client and host or server, respectively.  For 
encrypted data, check the Use Authentication box. 

Normally, the establishment of an SSL connection requires that the name in the host certificate match 
the address (FQDN/IP Address) used to make the connection.  Sometimes, a site may require a host 
certificate created with a name different from its address.  In this case, place the name on the certificate 
in the Alternate Principal Name field. 
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Book3 - Miscellaneous 

Running Minimized 
To run the T27 eXpress Plus Print Service Manager minimized, add the "m" option to the command line.   

Using to Windows task bar, locate and right click the icon titled "T27 eXpress Print Manager."  Add the 
"m" option to the Target text box.  For example: 

 "C:\Program Files\ ... \T27PrintManager.exe m" 

Error Handling 

WINSOCK Error Explanation and Possible Action 

"[10004] Interrupted system call" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10009] Bad file number" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10013] Permission denied" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10014] Bad address" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10022] Invalid argument" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10024] Too many open files" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10035] Operation would block" In the unlikely event this error occurs, please call 
KMSYS Worldwide for assistance. 

"[10036] Operation now in progress" In the unlikely event this error occurs, please call 
KMSYS Worldwide for assistance. 

"[10037] Operation already in progress" In the unlikely event this error occurs, please call 
KMSYS Worldwide for assistance. 

"[10038] Socket operation on non-socket" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10039] Destination address required" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10040] Message too long" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10041] Protocol wrong type for socket" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10042] Bad protocol option" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10043] Protocol not supported" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10044] Socket type not supported" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10045] Operation not supported on 
socket" 

If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10046] Protocol family not supported" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10047] Address family not supported by 
protocol family" 

If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10048] Address already in use" IP Address conflict on network or stack.  Seek 
assistance from your network administrator. 

"[10049] Can’t assign requested address" IP Address conflict on network or stack.  Seek 
assistance from your network administrator. 

"[10050] Network is down" Problem with TCP/IP network or stack.  If eXpress 
Connect has been working, wait awhile.  If eXpress 
Connect has not been working, seek assistance from 
your network administrator. 

"[10051] Network is unreachable" Problem with TCP/IP network or stack.  If eXpress 
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Connect has been working, wait awhile.  If eXpress 
Connect has not been working, seek assistance from 
your network administrator. 

"[10052] Net dropped connection or reset" Problem with TCP/IP network or stack.  If eXpress 
Connect has been working, wait awhile.  If eXpress 
Connect has not been working, seek assistance from 
your network administrator. 

"[10053] Software caused connection abort" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10054] Connection reset by peer" In the unlikely event this error occurs, please call 
KMSYS Worldwide for assistance. 

"[10055] No buffer space available" Quit all Windows applications, exit Windows and 
reboot your PC. 

"[10056] Socket is already connected" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10057] Socket is not connected" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10058] Can’t send after socket shutdown" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10059] Too many references, can’t splice" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10060] Connection timed out" If this error occurs, try shutting down Windows and 
perform a hard boot (reset button or power-
off/power-on) of your PC.  If the problem persists, 
please call KMSYS Worldwide for assistance. 

"[10061] Connection refused" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10062] Too many levels of symbolic links" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10063] File name too long" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10064] Host is down" Remote system is not responding. 

"[10065] No Route to Host" There is no Route to remote system.  Check address 
and router address. 

"[10066] Directory not empty" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10067] Too many processes" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10068] Too many users" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10069] Disc Quota Exceeded" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10070] Stale NFS file handle" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10071] Too many levels of remote in path" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10091] Network SubSystem is 
unavailable" 

If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[10092] WINSOCK DLL Version out of 
range" 

WINSOCK must be version 1.1 or higher.  Contact 
your WINSOCK vendor for a new version. 

"[10093] Successful WSASTARTUP not yet 
performed" 

If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[11001] Host not found" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[11002] Non-Authoritative Host not found" If this error occurs, please call KMSYS Worldwide for 
assistance. 

"[11003] Non-Recoverable Error_Handling: 
FORMERR, REFUSED, NOTIMP" 

If this error occurs, please call KMSYS Worldwide for 
assistance. 
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"[11004] Valid name, no data record of 
requested type" 

If this error occurs, please call KMSYS Worldwide for 
assistance. 

 

Technical Support 
If you are experiencing difficulties configuring eXpress Connect or are experiencing run-time difficulties, 
please consult the person responsible for maintaining communications at your site for assistance.  If 
difficulties persist, please contact the Technical Support Group at KMSYS Worldwide, Inc.  Obtain 
assistance over the Internet at www.kmsys.com, by email at support@kmsys.com or telephone at (770) 
635-6363. 

 

http://www.kmsys.com/
mailto:support@kmsys.com
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